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Introduction

The purpose of graduate study is to provide academic opportunities to extend the
boundaries of knowledge and experience. These opportunities enable qualified
individuals to obtain a comprehensive and thorough understanding of a more specific
body of knowledge.

A thesis or research paper constitutes a tangible measure of academic achievement. The
candidate for a master’s degree is expected to have a strong general knowledge of the
field and competence in the research and applied skills recognized in that field. The
candidate and the Advisory Committee share with the University the responsibility for
protecting and improving this quality. The value of any research or scholarly activity is a
direct result of the skill with which it is communicated to fellow specialists and other
educated people. Bemidji State University subscribes to the highest ethical standards in
the conduct of all scholarly endeavors. In this regard, all sources contained in the
investigation shall be given proper credit.

The candidate, as the principal investigator and author, is expected to display initiative in
planning a satisfactory program of investigation, in completing the investigation, and in
writing a thesis or research paper in accordance with the requirements of both the general
graduate guidelines and the department/program style requirements. Theses and research
papers differ primarily in representing different levels of investigation, specialization, and
presentation. Although there are important differences in the level of investigation
represented by the master’s thesis and research paper, both are similar end products of
investigation. Both must conform to certain fundamental rules of literary and scholarly
presentation.

A research project involves the collection, evaluation, and effective presentation of
information pertaining to a clearly defined problem of a limited scope. The degree
candidate is expected to perform in a manner that demonstrates respect for grammatical
principles and to reflect competent literary style. The mode of scholarly presentation will
vary according to the different fields of knowledge. The research process requires close
contact between the degree candidate and the entire advisory committee.



Thesis, Research Paper, and Graduation Expenses

All thesis and research paper candidates are required to register for credit at the time
when the initial investigation commences. The precise number of thesis/research paper
credits required may vary:

e The thesis credit requirement may not exceed six (6) semester hours.

e The research paper may not exceed two (2) semester hours.

The candidate is expected to meet with his/her advisor for the purpose of presenting an
initial topic proposal to the Advisory Committee. This meeting should occur prior to
initiating the investigative process. The candidate should also seek input and approval
from all committee members on the research topic.

EXxpenses

The actual expenses incurred in the preparation and duplication of the thesis/research
paper will vary. The following is a list of expenses that may be incurred:

1. A word processing service fee (optional).

2. Twenty-pound, 25 to 100 percent rag or cotton bond paper (required for the final
thesis copy only).

3. Photocopying of the four draft copies to be provided to the three Oral
Examination Committee members and the Graduate Faculty Representative.

4. Photocopying of any requested revisions by the Dean, School of Graduate
Studies.

5. Submission of final paper:

a. Thesis: Bindings for the two final copies of the thesis (one twenty-pound
copy and one photocopy for the library and any additional for personal use)
are to be submitted to the School of Graduate Studies once appropriate
signatures have been secured.

b. Research Paper: A single research paper photocopy (with original signatures
of committee members and Graduate Faculty Representative) for the
department must be submitted to the School of Graduate Studies. Research
papers are not provided to the library.

6. Inaddition, a $10 graduation fee made payable to Bemidji State University must
be attached to the Application for Graduation and submitted to the School of
Graduate Studies.



Eleven Steps to the Successful Completion of the Thesis or Research Paper

10.

Once approval has been given for Admission to Candidacy, the candidate selects
a research topic or problem with the approval of the advisor.

The candidate determines the members of the master’s committee in consultation
with the advisor.

The candidate prepares a proposal on the research topic for presentation to the
committee members. Once all committee members approve the topic, Form 3,
Graduate Research Paper/Thesis Proposal Approval, is signed by committee
members and submitted to the School of Graduate Studies.

The candidate conducts the necessary investigation with the guidance of the
advisor and in conjunction with the committee members. If the investigation will
involve human subjects, please contact the School of Graduate Studies for the
appropriate approval forms.

The initial draft is provided to the advisor for review. Once the advisor has
reviewed the draft, a copy is provided to all members of the master’s committee.

The candidate will submit Form 4, Application for Graduation, and be assigned a
graduate faculty representative. Note: Candidates should register for the
thesis/research paper credits with the advisor at this time during the
semester or summer session in which the oral defense is scheduled.

When the members of the student’s graduate committee have read and provided
feedback to the student, the candidate will secure signatures on Form 5, Pre-
Defense Signature, and submit the form to the School of Graduate Studies.

A copy of the approved draft is provided to the School of Graduate Studies at
least three weeks prior to the date of the oral examination. The approved draft will
be reviewed for formatting and then forwarded to the appointed graduate faculty
representative.

The candidate defends the thesis/research paper at the oral examination. The
committee may request modifications or changes to the draft, based on the oral
defense.

All modifications or changes to the thesis/research paper must be completed to the
satisfaction of the advisor.



11. Provide approved manuscript(s) to the advisor and committee for signatures. Then
submit the manuscript(s) to the Dean, School of Graduate Studies.

a. The thesis candidate must provide two (2) approved manuscripts for
signatures. One thesis copy must be on twenty-pound, 25 to 100 percent rag or
cotton bond paper. The copies must be two- or three-hole punched and bound
in a black left-sided, heavy-duty report cover with metal fasteners. The exact
title of the thesis and the full name of the author must appear on the front
cover.

b. The research paper candidate must provide one (1) approved manuscript for
signatures. Regular printer paper may be used for the research paper. The
copy must be two- or three-hole punched and bound in a black left-sided,
heavy-duty report cover with metal fasteners. The exact title of the research
paper and the full name of the author must appear on the front cover.



Page Sequence of a Thesis or Research Paper

Every thesis or research paper submitted to the School of Graduate Studies must conform
in every aspect to the following requirements.

See page
1. Label 0N frONt COVEN......ooiieiee e 15
2. Blank sheet (fly leaf) - unnumbered
3. Front page — UNNUMDEIEA ........coouiiiiiiiiiiie e s 16
4. Title page - sSmall ROMAN T......ccccoviiiiiciice e 17
5. Author and Approval page - small ROman ii........ccoccevenieniiiinnnece e, 18
6. Abstract page - sSmall ROMaN fil......cccccvevveiiieiiiieiiese e 19
7. Acknowledgments page (optional) - small Roman iv...........c.ccoevnveinnnnnn. 20
8. Table of Contents page(s) - small Roman number(s) .........cccccevvereriverinennn. 21
9. List of Tables page - small Roman number...........ccccooviniiiiiencneee, 23
10. List of Figures page — small Roman nUMDEr...........cccccevviveveeneeriesie s 24

11. Text pages — numbered (Arabic)

12. References, Bibliography, or Works Cited page(s) — numbered (Arabic)....30
13. Appendix page(s)* - numbered (Arabic)

14. Blank sheet (fly leaf) - unnumbered

Note: All page numbers, both Roman and Arabic, are to be placed in the upper
right hand corner of the page. The placement is 1/2* from the top of the page and
aligned with the right margin.
APA: Page numbers are required. A page header (the first two or three words
of the title) is optional; see p. 288 of the APA Manual.
MLA: Last name of student and page number are required.

* The appendix page(s) follow the References, Bibliography, or Works Cited pages only
if there are no references cited in any appendix. If any appendix contains
reference citations, the References, Works Cited, or Bibliography pages follow the
appendix pages.



General Guidelines

The mechanics: The department/program style manual takes precedence over all general
guidelines with the exception of the front matter pages.

Abstract — The final required element in the preliminary or front matter (before the
Table of Contents) is the abstract. The abstract should begin with a clear statement of the
problem. The purpose of the abstract is to summarize concisely the methods of
investigation, significant content, system of analysis, findings and conclusions of the
study. The abstract statement should not exceed 300 words. The abstract is to be written
in the same person and tense as the text. (For a more comprehensive treatment, see The
Thesis Writer’s Handbook, by Joan I. Miller and Bruce J. Taylor, 1987, West Linn,
Oregon: Alcove Publishing Company.) (See p. 19.)

Acknowledgments — Acknowledgments recognize the person(s) to whom the student is
indebted for encouragement, guidance and special assistance. This page should also
include recognition of any grants or financial assistance that was received to support the
research. This page is optional. No part of the thesis/research paper that is essential to
the understanding of the main body of the text should appear on the acknowledgment
page (See p. 20.)

Appendix Pages — An appendix contains material that is useful for detailed review, but is
not essential to the study. For example, an appendix is an appropriate section in which to
place certain kinds of tabular and graphic material. This material is available as
supporting data even though it may not be specifically utilized in the text. However, such
material must be referenced in the text.

Each appendix is identified by a letter in a sequence independent of the
numbering system used for the chapters. However, the page(s) of an appendix are
numbered in sequence with those in the text. Each appendix must begin on a new page
and must be listed in the Table of Contents. The appendix pages follow the References,
Bibliography, or Works Cited pages only if there are no references cited in any
appendix. Consult the required department/program style manual for the correct form.

Author Approval Form — There are two primary purposes for this page. The first
indicates approval of the thesis/research paper by the advisor and Dean, School of
Graduate Studies. The second protects the research from unauthorized use. The author
approval form should follow the title page. (See p.18.)

Binding — Approved manuscript(s) with original signatures of the committee members
and graduate faculty representative must be submitted to the School of Graduate Studies
in a bound format. A black heavy-duty report cover with metal fasteners (two- or three-
hole punch) is required. The exact title of the thesis or research paper and the full name of
the author must appear on the front cover.

Thesis: Two (2) approved manuscripts of the thesis must be bound and submitted.

(See the Paper section for further details.)
Research Paper: One (1) copy of the research paper must be bound and submitted.



Capitalization — All research projects must conform to standard rules in the use of
capitalization. (See the appropriate department/program style manual, i.e., MLA, APA,
etc.)

Centering — All word-processed copies should be centered within the margins of the
paper, not within the 8 1/2 x 11 inch page. The margin spacing will vary depending on
the type style selected. This requirement also applies to charts, tables, graphs, figures, or
other reproductions.

Chapter Headings — See APA manual, pages 113-115; MLA: See page 29 of this
handbook.

Copies Required — Four draft copies are required for the examination committee. One
copy is to be provided to the School of Graduate Studies at least three weeks prior to the
oral examination. This copy will be provided to the graduate faculty representative.

Copyright — Many theses typically are not copyrighted. If the thesis will be published, it
should be copyrighted. A copyright notice should be included in the title page.

Duplication — Two methods have been approved for the reproduction of the
thesis/research paper. The first acceptable method consists of a photocopy of the original.
The second method includes two copies produced on a word processor. All copies must
be neat and clean. Inferior photocopies or those with dirty, smudged, or streaked
backgrounds will not be approved. Pages of illustrations or graphs that can not be
corrected on a word processor may be printed by an approved alternative process. It is
recommended that candidates consult with the Dean, School of Graduate Studies for the
purpose of reviewing alternative processes.

Erasures and Strike-Overs — Erasures and strike-overs are not permitted on the final
copies. Correction fluid may not be used in the removal of errors.

Figures — The captions should conform to the guidelines in the approved style manual. If
figures are involved, the List of Figures page(s) should immediately follow the Table of
Contents and any List of Tables page(s) in the front matter.

Fly Leaf — The fly leaf sheets are not numbered. The purpose of these sheets is to protect
the title page and back matter. The fly leaf blank sheets should precede the title page and
follow the last page in the manuscript.

Front Matter — This section consists of all preliminary information prior to the

presentation of the text (e.g., title page, statement by author, abstract). (See Appendix A,
beginning on p. 14.)
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List of Tables — The entries should be identical to the table titles in the text and conform
to the guidelines in the approved style manual. The List of Tables page(s) should
immediately follow the Table of Contents page(s) in the front matter. (See p. 23.)

Margins — The text margin guidelines are contained in the departmental/program style
manual. Generally, the left margin must be one and one-half inches (1% *) in width with
the other margins (top, right, bottom) one inch in width. All typing, reproductions,
appendices, and footnotes, must be within the margins. All page numbers are to be %2 "
from top of page aligned with the right margin. The text of the paper must be double
spaced, with the exception of lengthy quotations and the bibliography. Consult with the
required departmental/program style manual.

Page Numbering Sequence — All front matter pages (the front section) must be
numbered in Roman Numerals. The title page is counted as the first page, and is
numbered “i”. All text pages must carry Arabic numbers beginning with “1”. Every page
must be accounted for in the numbering system with the exception of the fly leaf sheets
and the author approval page. MLA: Last name and Arabic numbers must appear on all
pages of the research/thesis paper.

Paper — The paper to be used for final library approved thesis (not research papers)
manuscript copy must be 8% x 11 inches. Thesis paper must be twenty-pound bond
having 25 to 100 percent rag or cotton content. The second copy may be a photocopy.
Erase, correctable, or other erasable bond paper is not acceptable. Continuous feed paper
cannot be used. The entire paper must be of the same quality, the same brand, and the
same degree of whiteness. Bond paper is water marked. The paper should be arranged so
the watermark is both right side and top-side up (see Word Processing). For the research
paper, 20-pound, non-cotton printer paper is acceptable.

Photocopying — Very specific rules and guidelines govern the circumstances under
which photocopying may occur. Contact with the University Library is suggested when
the use of copyrighted works will be used in the text. Guidelines are also available in the
Copyright Office Circular R21, “Reproduction of Copyrighted Works by Educators and
Librarians.” This publication is available through the United States Copyright Office.

Preface — (See the Acknowledgments section.)

Questionnaires, Surveys, and Related Materials — The purpose of illustrative material
is to present information or data in a format more clearly than it can be stated in words
alone (see the Figures section). All illustrative materials must be presented on an 8%z x
11 inch page and within the acceptable margins. The candidate is encouraged to consult
with the department/program style manual because of the variability in the nature of
illustrations. Students who plan to use human subjects in their research must seek
approval from the Human Subjects Committee prior to collecting the data. Contact
the School of Graduate Studies for the appropriate approval form.

11



References, Works Cited, or Bibliography — All studies must contain source
information. In most instances, the source information is called References or Works
Cited and consists only of sources cited in the text or appendices. The References, Works
Cited, or Bibliography pages should follow the text, and the pages are numbered in
sequence with the text. If any appendix contains reference citations, the References,
Works Cited, or Bibliography pages follow the appendix pages. Consult the
department/program style manual for the correct form. (See p. 30.)

Special Mountings with Adhesives — A large photograph or a full page of photographic
illustrations should be directly on photographic paper 8% x 11 inches. However, if
photographs or other materials requiring special mountings are included, the paper for
mounts should be “Alexis” Lietz Sequbio (#1005), or pliable Bristol Board in sheets 8%z x
11 inches. The adhesive may be Kodak dry mounting tissue or polyvinyl plastic adhesive,
such as Duratite, Wilhold, or Borden’s. Do not use rubber cement under any
circumstances. Double-faced scotch tape may be used if special care is exercised so as
not to allow the tape to show.

Style Manuals — Each department/program has a required style manual to be used for the
thesis/research paper. The most recent edition is to be used in all research.

Biology — After consent with their advisors, students will follow the format of an
appropriate journal in their area of expertise.

Education — Publication Manual of the American Psychological Association, 5th ed.,
Washington, D.C.: American Psychological Association.

English — The thesis or research paper is written using either the APA or MLA style
manual as determined by the major advisor.

Environmental Studies — After consent with their advisors, students will follow the
format of an appropriate journal in their area of expertise.

Industrial Technology — Publication Manual of the American Psychological
Association, 5th ed., Washington, D.C.: American Psychological Association.

Mathematics — Publication Manual of the American Psychological Association, 5th
ed., Washington, D.C.: American Psychological Association.

Science — The body of the thesis/research paper must conform to the
recommendations of the style manual specified in the catalog by the area of science in
which the thesis/research paper is written.

Sport Studies (Physical Education) — Publication Manual of the American

Psychological Association, 5th ed., Washington, D.C.: American Psychological
Association.

12



Table of Contents — The Table of Contents is a complete listing with page numbers of
all sections of the thesis or research paper. Since most theses and research papers do not
have an index, it is desirable to have the Table of Contents be a detailed listing of all
major subdivisions of the text rather than just a list of chapter headings.

Entries — It is essential that wording in the Table of Contents listing be identical
to that of the heading in the text in every case. Consult with the approved
department/program style manual. A sample Table of Contents is provided on p. 21.

Page Numbers — Align the page numbers flush right with dot leaders. In Microsoft®
Word, go to the Format menu and select Tabs. Type in the tab stop position and select
Alignment Right and Leader 2 ....... .

Word Processing — The final copy must be produced on a letter quality printer.

Text — The text is the main body of the thesis/research paper. Double-space except
where otherwise indicated. Single-space block quotes, table titles and headings,
figure captions, notes in tables and figures, and footnotes.

The text is divided into sections called Headings (i.e. chapters, subdivisions). There
must be an exact correspondence between the headings in the text and the
entries in the Table of Contents.

To center text vertically on a page:

1. Show formatting symbols: On the Standard toolbar, click on the | icon.

2. At the bottom of the previous page, insert a section break: In the Insert
menu, select Break; under Section break types, select Next page.

3. On that next page, type the text to be centered vertically.

4. At the bottom of the page, insert a section break.

5. Center the page vertically: (a) Go back to the page to be centered vertically.
(b) In the File menu, select Page Setup; go to the Layout tab; under Page,
Vertical alignment, select Center. (c) Be sure that the Apply to: box shows
this section, and click on OK.

Title Page — The title page contains the exact title of the thesis or research paper, the
full name of the author, the degree to be awarded, the institution granting the degree,
and the year the degree will be granted (p.17). The title page is to be followed by the
Statement by the Author and Approval Form (p. 18). There is no difference between
the title page of a thesis paper or research paper. If the title is more than one line, an

inverted pyramid must be used. No title should be more than three lines.

Type Styles and Symbols — One size of type (12 pt. font preferably) must be used
throughout the paper. Hand-drawn symbols should be in India ink or other high-
contrast black ink. In fields such as Environmental Studies, special circumstances
may require the use of a color on a map or diagram. Color may be used only when it
is standard practice in the specific field.

13



Appendix A:

Sample Front Matter Pages
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This is a sample of the label that goes on the front of the binder(s) for the thesis or
research paper.

Do not include this
INn your paper.

THE TITLE IS IN ALL CAPS, CENTERED, AND
SINGLE SPACED FOR THE THESIS OR
RESEARCH PAPER
(1 blank line)
by
(1 blank line)

John H. Doe

Label size is approximately 2"x 4”. Text must be centered vertically and
horizontally. The label must be affixed to the front cover of the bound thesis
copies (2) or research paper (1).

15



(no page number)

Establish a left margin of 1.5 inches on ALL pages for binding purposes and be certain
to maintain a margin of at least 1 inch on the top, right, and bottom of the page.
From the 1-inch top margin, text begins on line 33, typed in upper and lower case,
single-spaced, and centered. Do not place a page number on this page.

School of Graduate Studies
Bemidji State University
1500 Birchmont Dr NE, # 30
Bemidji, MN 56601-2699
218-755-2027

16



Sample Title Page

Margins: 1.5 “ left; 1” top, right, and bottom. Center the text vertically on this page
(see Word Processing, Text, p. 13). Use Roman numeral page numbers on Front
Matter pages; place the numbers %2 inch from top edge, flush with right margin.

A DISCRIMINATIVE STUDY OF METHODS FOR
THE QUALITATIVE DETERMINATION OF FLORINE
(1 blank line)
by
(1 blank line)

William Robert Howard

(7 blank lines)

(line is 20 spaces long)

(7 blank lines)

A Thesis Submitted to the Faculty of the
DEPARTMENT OF ENVIRONMENTAL STUDIES
(1 blank line)

In Partial Fulfillment of the Requirements
For the Degree of
(2 blank lines)

MASTER OF SCIENCE IN ENVIRONMENTAL STUDIES
(2 blank lines)

BEMIDJI STATE UNIVERSITY
Bemidji, Minnesota, USA
(1 blank line)
June 2005
(1 blank line)
Copyright 2005 by William Robert Howard
(optional copyright notice)

17



Sample Statement by the Author and Approval Page

The Title and Statement by the Author must begin 3 inches from the top edge of the
paper or 11 blank lines from the 1-inch top margin. Candidates completing a
research paper should substitute “research paper” for “thesis” where it appears on this
page. The first paragraph contained below is not required for the research paper.
Roman numeral page number must be % inch from top edge and flush with right
margin.

STATEMENT BY THE AUTHOR

(1 blank line)
This thesis has been submitted in partial fulfillment of requirements for an advanced
degree at Bemidji State University and is deposited in the University Library to be made
available to borrowers under the rules of the library. (First paragraph is to be included
in thesis papers only — delete for research paper.)

(1 blank line)
Brief quotations from this thesis are allowable without special permission, provided
accurate acknowledgement of the source is indicated. Requests for permission to use
extended quotations or to reproduce the manuscript in whole or in part may be granted by
(insert name of department/program) or the Dean, School of Graduate Studies when
the proposed purpose is in the interest of scholarship. In all other instances, however,
permission must be obtained from the author.

(1 blank line)
Signed:

(Student: Please sign final paper before you submit it to your advisor.)
(3 blank lines)

(line is 50 spaces, centered)
(2 blank lines)
APPROVAL BY THESIS ADVISOR

(2 blank lines)
THIS THESIS HAS BEEN APPROVED ON THE DATE SHOWN BELOW:

(3 blank lines)

(Name of Professor), Date
Committee Chair
Professor of (Department Name)

Dean, School of Graduate Studies Date

(do not list the name of the Dean)

18



Sample Abstract

Margins: 1.5 “ left, 1” top, right, and bottom. Center the text vertically on this page
(see Word Processing, Text, p. 13). Title and name must match those on the title
page. Title and name must match those on the title page. Title must be in all caps and
centered; author’'s name is typed in upper- and lower-case lettering and centered. The
abstract statement should not exceed 300 words. Roman numeral page numbers
must be %2 inch from top edge, flush with right margin.

LEARNING ABOUT THE VALUE OF
GLOBAL COOPERATION
(1 blank line)
John Q. Public
(2 blank lines)

As a corollary to Robert Angell’s measures of world order, this study examines nation-
state differences in support for world order as a function of learning through involvement
in the United Nations. Differences in national support for world order are analyzed in
terms of “role-taking” and “cue-taking” in the United Nations. Seven types of roles,
based on the degree to which nation-states approximated support for the norms of the
organization, are identified. Correlational analysis indicates that these roles function as
good predictors to variance among nations in their support for world order. Alternatively,
nations which could not be classified as taking on a definitive role were hypothesized to
be “taking cures” about the value of global cooperation from their regional counter parts.
This predicted outcome was also supported. Finally, analysis of “deviant” cases
indicated that for some nations, both role-taking and cue-taking may be equally salient
for supporting world order.

(1 blank line)
Approved by:

(2 blank lines)

Committee Chair Date

Committee Member

Committee Member

Graduate Faculty Representative

(2 blank lines between Committee Chair and signature lines throughout)

19



Sample Acknowledgments Page

This page is optional. Margins: 1.5” left, 1” top, right, and bottom. Roman numeral
page number must be %2 inch from top edge and flush with right margin. Text

should be centered and begin 3” from top of paper or 11 blank lines from the
1-inch top margin.

ACKNOWLEDGMENTS

The author wishes to thank Jane Doe
for her special assistance in the
preparation of this manuscript.
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The following example is for athree levels of headings paper in the APA format.
For a two, four, or five levels of headings paper, please refer to pages 113-115 of
the APA manual and pages 25-26 of this handbook. Headings must be presented
in a format identical to the form used in text.

Roman numeral page number must be %2 inch from top edge and flush with right
margin. Margins are 1.5” left, 1" top, right, and bottom. Center all text vertically
within the margins.

TABLE OF CONTENTS
(1 blank line)
LIST OF TABLES ... .ottt ettt st st nreans vii
(1 blank line)
LIST OF FIGURES ..ottt sttt viii
(1 blank line)
Chapter Page
1. Introduction
Statement of the Problem ... 1
Background of the Problem ... 2
Limitations and AsSUMpPtions Of STUAY ..........cooveieieiiinniie e 3
DEfiNItIONS OF TEIMS......oviiieiicieiieeee bbb 4
(1 blank line)
2. Review of Literature (Level 1)
General Components of Service Learning (Level 3)......cccccovviiiiininnennne 7
Examination of Current School-Community Relationship (Level 3) .............. 10
Methods of examinations (LeVel 4) ... 10
Results of examinations (Level 4)........ccccccvvvevveveiieve e 12
Matching Service Learning Outcomes to School and Community
Expectations (Level 3, heading too long for one linge) ..........c........... 17
Direct benefits for those being served (Level 4) ... 22
Problems encountered within established programs (Level 4)........... 25
Working together for success (Level 4).......cccoovieiiiiiiieneiieneeas 27
(1 blank line)
3. Results
Demographics of RESPONAENLS........cceevuviieiieie e 31
First subheading title ..o 31
Second subheading title ...........cccoevveiiieie e 31
Question 1, Important Issues Facing DIStriCtS .........ccccovviiiiiiiiieieee e 32
Title Of the FIrSTISSUB......ocviiiiiiieeee s 32
Title Of the SECON ISSUE .....cviivveiiiiiieie e 32
Question 2, Teaching Values in Public SChools .........c.ccccooevviviiiiiicciiee 32
Question 3, Rating the School-Community Relationship............cccocvieniennne 33
Question 4, Making the Relationship Stronger...........ccccvveviveveiciieeie s 33

See the next page for formatting (1) a two-page Table of Contents (TOC), (2) the
page numbers in the TOC, and (3) a very long heading.
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Vi

4. Discussion
Interpretation of SUIVEY RESUILS..........ccoiveiiiieciece e 34
Implications Service Learning Could Have on This District ............cc.ccevee. 37
Suggestions for Further ReSearch ..........cccoovvveiiiie i 39
(1 blank line)
71 o] [0 o] =] 0 YRS 40
(1 blank line)
Appendix A. SUrVeY QUESLIONNAITE .....cc.veveiierieeieseeseeie e sieeeeseeste e sreesee s e sreesaeeneenes 41
(1 blank line)
APPENdIX B. SUINVEY RESUILS .....cvveieiiieiieee et nnes 43

Two-page TOC — If the Table of Contents is too long for one page, insert a break
between sections and continue on the next page. Begin the continuation at the 1-inch

top margin.

Page Numbers — Align the page numbers flush right with dot leaders. In Microsoft®
Word, go to the Format menu and select Tabs. Select or type in the tab stop position
and select Alignment Right and Leader 2 ....... . Please note that the page numbers
are not italicized.

Very Long Heading — Be sure no heading extends into the page listing area. Continue a
long heading indented on the next line. List the page number opposite the last line of the
heading.
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vii

LIST OF TABLES
(1 blank line)
Table Page
1. Title Of the FIrst TADIE ....cooeviiicie e 2
(1 blank line)
2. Title Of the NeXt TabIE......ccvie e 5

Roman numeral page number must be %2 inch from top edge and flush with right
margin. Margins are 1.5” left, 1” top, right, and bottom. Begin the text at the 1-inch
top margin.

Page Numbers — Align the page numbers flush right with dot leaders. In Microsoft®
Word, go to the Format menu and select Tabs. Select or type in the tab stop position
and select Alignment Right and Leader 2 ....... . Please note that the page humbers
are not italicized.
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viii

LIST OF FIGURES

(1 blank line)
Figure Page
1. Caption for the first figure, serving as an explanation of the figure
and as @ fIGUIE TIHIE. ... 7
(1 blank line)
2. Caption for the SeCONd fIQUIE. ......cciiiiiieieee s 10

Roman numeral page number must be %2 inch from top edge and flush with right margin.
Margins are 1.5” left, 1" top, right, and bottom. Begin the text at the 1-inch top margin.

Captions -- Be sure no caption extends into the page listing area. Continue a long
caption on the next line. If a caption is lengthy, the entry in the List of Figures may be
shortened to the first common point of punctuation (comma, colon, semi-colon, or
period), and all entries must be consistent with the format chosen. List the page number
opposite the last line of the caption.

Page Numbers — Align the page numbers flush right with dot leaders. In Microsoft®
Word, go to the Format menu and select Tabs. Select or type in the tab stop position
and select Alignment Right and Leader 2 ....... . Please note that the page numbers
are not italicized.
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(Arabic page number)

Chapter Headings (APA and MLA styles)

Arabic page number must be %2 inch from top edge and flush with right margin.
Margins are 1.5" left, 1” top, right, and bottom.

Exceptions to double-spaced text: See Word Processing (p. 13).

APA Style: Please refer to the APA Manual, 5th edition, and pages 113-115, to
determine how your headings should appear. Find the section of your paper that
breaks into the finest level of subordinate categories. Then use the guidelines that
follow to determine the level, position, and arrangement of headings.

One level. Only use Level 1. Start each chapter on a new page.

Example:
Centered Uppercase and Lowercase Heading
(1 blank line)
The indented, double-spaced text starts here. All headings (Level 1) are centered

and uppercase and lowercase.

Two Levels. Use Levels 1 and 3. Start each chapter on a new page.

Example:
Chapter 1: Title of the Chapter
(1 blank line)
The indented, double-spaced text starts here. The chapter headings (Level 1) are
centered and uppercase and lowercase.
Sub-heading Title
(1 blank line)
The indented, double-spaced text starts here. The sub-headings (Level 3) are flush

left, italicized, and uppercase and lowercase.
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Three Levels. Use Levels 1, 3, and 4. Start each chapter on a new page.

Example:
Chapter 2: Title of the Chapter
(1 blank line)
The indented, double-spaced text starts here. The chapter headings (Level 1) are
centered and uppercase and lowercase.
Sub-heading Title
(1 blank line)
The indented, double-spaced text starts here. The sub-headings (Level 3) are flush
left, italicized, and uppercase and lowercase.
Sub-heading of the sub-heading. These sub-headings (Level 4) are italicized and
indented five spaces. Only the first word in the subheading is capitalized, and the sub-

heading ends in a period. Double-spaced text immediately follows the sub-heading on the

same line.

Four Levels. Use Levels 1, 2, 3, and 4. Start each chapter on a new page.

Example:
Chapter 3: Title of the Chapter
(1 blank line)
The indented, double-spaced text starts here. The chapter headings (Level 1) are
centered and uppercase and lowercase.
Sub-heading of the Chapter
(1 blank line)
The indented, double-spaced text starts here. The sub-headings of the chapter
(Level 2) are centered, italicized, and uppercase and lowercase.
Sub-heading Title
(1 blank line)
The indented, double-spaced text starts here. These sub-headings (Level 3) are

flush left, italicized, and uppercase and lowercase.
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Sub-heading of the sub-heading. These sub-headings (Level 4) are italicized and
indented five spaces. Only the first word is capitalized, and the sub-heading ends in a

period. Double-spaced text immediately follows the sub-heading on the same line.

Five Levels. Use Levels 1-5. Start each chapter on a new page.

Example:
CHAPTER 2: REVIEW OF THE LITERATURE
(1 blank line)

The indented, double-spaced text starts here. The chapter headings (Level 5) are
centered and uppercase.

General Components of Service Learning
(1 blank line)

The indented, double-spaced text for this section of Chapter 2 starts here. The

heading (Level 1) is centered and uppercase and lowercase. ...
Methods of Examinations
(1 blank line)

The indented, double-spaced text for this sub-section of Examination of Current
School-Community Relationship (in Chapter 2) starts here. The heading (Level 2) is
centered, italicized, and uppercase and lowercase. ...

Survey Document
(1 blank line)

The indented, double-spaced text for this sub-section of Methods starts here. The
heading (Level 3) is flush left, italicized, and uppercase and lowercase. ...

Response Results. These sub-headings (Level 4) are italicized and indented five

spaces. Only the first word is capitalized, and the sub-heading ends in a period. Double-

spaced text immediately follows the sub-heading on the same line.
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MLA Style: (Start each chapter on a new page.)

Chapter |
(1 blank line)
Introduction
(1 blank line)
Indent five and begin typing text. Text should be double spaced throughout the

research or thesis paper. Chapters should begin on a new page. Works Cited is to be

included in paper but not considered a chapter.

(New Page Example)
Chapter |1
(1 blank line)
Title of the Chapter
(1 blank line)
Indent five and begin typing text. Text should be double spaced throughout the

research or thesis paper. Chapters should begin on a new page. Works Cited is to be

included in paper but not considered a chapter.
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(Arabic page number)

References, Bibliography, or Works Cited

Arabic page number must be %2 inch from top edge and flush with right margin.
Margins are 1.5" left, 1” top, right, and bottom.

Follow instructions in your thesis/research paper manual:

e APA — 5th Edition: see Chapter 4, Reference List (pp. 215-281), and page 299
References — only the sources that are cited in your thesis or research paper
Bibliography — sources for background or for further reading; you may include
descriptive notes with the source listings

e MLA - 6th Edition: see Chapter 5, Documentation (pp.139-235)
Works Cited — all works cited in your text, including not only books and articles
but also films, recordings, television programs, and other non-print sources

The following formats can be used for either APA or MLA. If a resource listing breaks
between two pages, start the resource on a new page.

One format: hanging indent, single spaced, 1 blank line between each resource.

References (APA)
(1 blank line)

Kyle, R. M. J. (1965). School-to-work transition and its role in systemic reform of
education. Washington, D.C.: National Institute for Work and Learning, Academy
for Educational Development.

(1 blank line)

Luecking, R., & Fabian, E. (2000). Paid internships and employment success for youth in

transition. Career Development for Exceptional Individuals, 23(2), 205-210.
(1 blank line)

National Organization on Disability. (2002). What is the employability gap? Retrieved

December 2, 2004, from http://www.nod.org/content.cfm?id=968

Another format: hanging indent, double spaced throughout.
Works Cited (MLA)
(1 blank line)
Kyle, Robert. School-to-Work Transition and Its Role in Systemic Reform of Education.

Washington, D.C.: National Institute for Work and Learning, Academy for

Educational Development, 1965.
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Luecking, R., and E. Fabian. “Paid Internships and Employment Success for Youth in
Transition. Career Development for Exceptional Individuals 23.2 (2000): 205-
210.

National Organization on Disability. “What Is the Employability Gap?” 2 Dec. 2004

<http://www.nod.org/content.cfm?id=968>
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